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Service of Originating Summons

The Originating Summons for divorce together with the relevant documents must be served i.e., brought to the Defendant's 

notice within 12 months from the date of filing of the Originating Summons by the Plaintiff or Plaintiff’s Lawyer. Types of 

Service of Originating Summons :

1. Service of Originating Summons via SYC Portal.

2. Service of Originating Summons via Registered Post.

3. Service of Originating Summons via Personal Service.

4. Service of Originating Summons via Substituted Service (Summons (Application for Substituted Service) and 

Affidavit required to be filed).

For more details, please refer to :

https://www.syariahcourt.gov.sg/Divorce/Process-Divorce-Proceedings/Service-of-the-Originating-Summons

You are required to select and update the method you have selected via the Service of 

Originating Summons function.

https://www.syariahcourt.gov.sg/Divorce/Process-Divorce-Proceedings/Service-of-the-Originating-Summons
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Service of Originating Summons 

1 If you have filed the Originating Summons via SYC portal in e-

form, you will receive a task on your Dashboard: "Originating 

Summons Service Bundle" with status Pending Service.

This task will be available for one year in your dashboard 

after your filing of Originating Summons is accepted. You 

are required to serve the Originating Summons on the Defendant 

/ Defendant’s Lawyer within this period.

Click on the 3 dots under More Options and select View to start 

the update on Service of Originating Summons. Alternatively, 
you can click on the Case ID hyperlink.

2

Return to Contents

Return to Contents
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1b
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Service of Originating Summons

3 You will find a bundle (set of documents) of the 

Originating Summons and accompanying documents. The files in 

PDF format are generated and endorsed court documents of filed 

and accepted documents and consist of:

• Originating Summons (Form 6)

• Case Statement Husband or Wife (Form 7 or 8, depending on 

the Plaintiff's gender)

• Agreed Matrimonial Property Plan, or Plaintiff’s Proposed 

Matrimonial Property Plan (Form 13 or 15, if applicable)

• Agreed Parenting Plan, or Plaintiff Proposed Parenting Plan or 

(Form 11 or 12, if applicable)

The next set of files are DOCX (MS. Word) blank documents. 

These documents are required to be served on the Defendant.

Please download all the files in 3 and 4 (and print if necessary) to 
serve it to the Defendant.

To proceed to update Service of Originating Summons, click on 

the hyperlink Service of Originating Summons. Alternatively, 
you can click on Proceed to Divorce E-Services.

5

Return to Contents

Return to Contents
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Service of Originating Summons

6 You will be directed to Divorce E-Services > I want 

to…for Case with Originating Summons > Service of 

Originating Summons page. Please read the Description & 

Documents required.

Click on the hyperlink on Service of Originating Summons to 

continue.

You will be directed to the Case Access page. Key in the 

Originating Summons Number.  Click on Submit.

Return to Contents

Return to Contents

7

6

8a 8b
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Service of Originating Summons

9
You will find a selection of available options to Serve the 

Originating Summon, such as :

a) Attempt Service via Registered Post

b) Attempt Service via SYC Portal

c) File Summons (Application for Substituted Service 

and Affidavit)
d) Personal Service Attempt

For more details on each method of service, please refer to : 

https://www.syariahcourt.gov.sg/Divorce/Process-Divorce-

Proceedings/Service-of-the-Originating-Summons

Notes: 

Once you have selected a method, you are unable to change 

the method of attempt of service, until 21 days after the date 

of selection.

Once 21 days has lapsed and you have not taken action on the Task 

for that method of service, the system will send a new Task for you to 

provide Originating Summons Status Update on your dashboard, and 

you will be able to select a new Method of Service.

If the status of Service of OS on your Dashboard is ‘Draft’ or ‘Pending 

service’, and you engage a solicitor who files a Notice of Appointment 

of Solicitor which is accepted, the status of service of OS will be reset 

and the initial four options will be shows to your solicitor.  If the status is 

‘Served’, it will remain unchanged. 

Return to Contents

Return to Contents

9a

Service of Originating Summons – From Dashboard

https://www.syariahcourt.gov.sg/Divorce/Process-Divorce-Proceedings/Service-of-the-Originating-Summons
https://www.syariahcourt.gov.sg/Divorce/Process-Divorce-Proceedings/Service-of-the-Originating-Summons
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Service of Originating Summons

9 (Continued) You will find a selection of available options to serve 

the Originating Summons, such as :

a) Attempt Service via Registered Post

b) Attempt Service via SYC Portal

c) File Summons (Application for Substituted Service and 

Affidavit)

d) Personal Service Attempt by Court Process Server

For more details on each method of service, please refer to: 

https://www.syariahcourt.gov.sg/Divorce/Process-Divorce-

Proceedings/Service-of-the-Originating-Summons

Notes: 
Once you have selected a method, you are unable to change the 

method of attempt of service, until 21 days after the date of selection.

Once 21 days has lapsed and you have not taken action on the Task 

for that method of service, the system will send a new Task for you to 

provide Originating Summons Status Update on your dashboard, and 

you will be able to select a new Method of Service.

If the status of Service of OS on your Dashboard is ‘Draft’ or ‘Pending 

service’, and you engage a solicitor who files a Notice of Appointment 

of Solicitor which is accepted, the status of service of OS will be reset 

and the initial four options will be shows to your solicitor.  If the status is 

‘Served’, it will remain unchanged

Return to Contents

Return to Contents

9bService of Originating Summons – From Dashboard

9c

9d

https://www.syariahcourt.gov.sg/Divorce/Process-Divorce-Proceedings/Service-of-the-Originating-Summons
https://www.syariahcourt.gov.sg/Divorce/Process-Divorce-Proceedings/Service-of-the-Originating-Summons
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Service of Originating Summons

1 To update Service of Originating Summons from Divorce E-
Services, navigate to the Divorce tab.

2

Return to Contents

Return to Contents

Click on “Divorce E-Services”. 

Click on I want to ..for Case with Originating Summons Number

Select Serve Originating Summons for Divorce.

Please read through the Description & Documents Required.

To continue, click on the hyperlink on Service of Originating 

Summons

3

4

4

1

2

Service of Originating Summons – From Divorce E-Services
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Key in the Originating Summons Number (minimum 
5, maximum 20 digits).

Click on Submit to validate the Originating Summons Number.

If you have case access, you will find a selection of 

available options to serve the Originating Summons.  Refer to 

pages [10 and 11] of this guide for more details.

7

8

Return to Contents

Return to ContentsService of Originating Summons
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Return to Contents

Return to Contents

Attempt Service via Registered Post

If you would like to serve the Originating Summons via Registered  

Post, navigate to option A. Please read through the description for 

information on this method of service.

To select this method, click on Attempt Service via Registered 

Post.

2

1

1

2
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Return to Contents

Return to Contents

Read the checklist and confirm each point by clicking on the 

checkbox. The Update button will only be enabled once you 

have ticked all the checkboxes.

To proceed with the selection, click on Update. Alternatively, you 

can click on Back to Service of Originating Summons and 

will be directed to the Service of Originating Summons page.

Attempt Service via Registered Post

3

3

4

4
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Once you have clicked Update in step no. 4, you will find the 

completion screen. Click on Back to Dashboard to go back to 

Dashboard.

Return to Contents

Return to ContentsAttempt Service via Registered Post

5

5
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Return to Contents

Return to Contents

If you have selected Attempt Service via Registered Post, you are 

required to send or serve all the documents in the Originating 

Summons Service Bundle (refer to step nos. 3 and 4 in page 8) on 
the Defendant via registered post.

In order for the service to be considered valid, the Defendant must sign 

and return the Acknowledgement of Service Form to the Plaintiff, and 

the signed Acknowledgement of Service Form must be filed.

You will find a task on your Dashboard to Submit the Signed 
Acknowledgement of Service Form.

 

Click on the 3 dots under More Options and click View to file the 

signed Acknowledgement of Service Form. Alternatively, you can click 

on the Case ID hyperlink.

You may also locate the Acknowledgement of Service with the status 

‘Draft’ in the Divorce section, under Ongoing Filing.

Click on the 3 dots under More Options and select Edit to proceed

Submit Signed Acknowledgment of Service

6

7a

7b

7b

7c

7c

6
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Return to Contents

Return to Contents

Key in the date when the documents were served, under the Date  

Documents Served tab.

On the Address Documents Served tab, specify whether the 
address is :

a) Local, or,

b) Overseas

If you select Local address, key in the postal code.

Click on Retrieve Address.

Verify Block/House Number, Street Name & Building Name that will 

be auto populated.

Key in Level No. and Unit No.

If the address does not have a Level no. or a Unit No. select NO to 

the question “Does the address contain Level no. and/or Unit no.?”

Submit Signed Acknowledgment of Service

8

8

9

10 11

12 13

14

9

10

11

12

13

14
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Return to Contents

Return to Contents

If you select Overseas Address, select the Country from the 

dropdown list.

Key in the Address.

Key in the Postal Code.

Submit Signed Acknowledgment of Service

15

15a

15b

17

16

16

17
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Return to Contents

Return to Contents

To upload the signed Acknowledgement of Service Form, click on the 

Choose File button and upload the form in PDF format.

Once all fields are keyed in, and the Acknowledgement of 

Service Form is uploaded, the Preview button will be enabled. Click on 
Preview to view the Form in non-editable format before submission.

In the Preview Mode, verify all the keyed-in information & 
uploaded file.

Click Submit to continue.

Alternatively, click on Back to Edit to revert to edit mode.

Submit Signed Acknowledgment of Service

18

18

19

19

20

21

2123

20

22
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Return to Contents

Return to Contents

23

On the Declare section, read and confirm the declaration by clicking on 

the checkbox.

Click on Make Payment to continue.  Refer to pages 27 to 30 on 

Payment. 

23

24

Submit Signed Acknowledgment of Service

24



23

Return to Contents

Return to Contents

Once the Acknowledgement of Service has been submitted, you may 

view the status of the submission in the Divorce tab, in the Ongoing 

Filing section.

If the submission is Returned as Incomplete you may view the remarks 

by clicking View Remarks under the Remarks column.

Once the returned Acknowledgement of Service has been re-

submitted, you may view the status of the submission as indicated in 

step 25 above.

Submit Signed Acknowledgment of Service

25

26

26

25
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Return to Contents

Return to Contents

Once the Acknowledgment of Service is accepted, the submission will 

be shown in the Completed Filing section of the Divorce tab. 

The accepted Acknowledgement of Service may be found in the Court 

File -> Court Documents section of the Divorce tab.

27

28

Submit Signed Acknowledgment of Service

27

28
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Return to Contents

Return to Contents

Payment - PayNow

1

2

3

On the payment page, verify the breakdown of filing fees and the 
total amount.

Select Payment Mode. The default selection is PayNow.

Scan the QR code, proceed to pay by your PayNow mobile app.

Click on Verify Payment.4

1

2

3

4

Submit Signed Acknowledgment of Service
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Return to Contents

Return to Contents

Payment – E-Nets/Credit Card

5

6

7

On the payment page, verify the breakdown of items, fees 
and total amount.

Select E-Nets/Credit Card as the payment mode.

Key in your card details such as Name on Card, 
Number, CVV/CVV2, card expiry date & optional email address.

Click on Submit. Perform 2FA authorisation to pay on your 

mobile app/ SMS/email if required.

Or click Cancel to cancel the payment.

.

8

5

6

7

98

9

Service of Originating Summons – Make Payment
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Return to Contents

Return to Contents

Request Fee Waiver

10

11

12

On the payment page, verify the breakdown of 

items, fees and total amount.

If you are a SingPass user, you will be able to select Request Fee 

Waiver.

Once you have selected Request Fee Waiver, provide the reason 

for fee waiver request.​ If the reason selected is Other Grounds, please 

specify the other grounds.

You will be required to upload the supporting documents, for example, 

your Financial Assistance Letter. Click on the Choose File button and 

upload the document.

Click on Submit Request for Fee Waiver to submit the request. 

10

11

12

14

13

14

Service of Originating Summons – Make Payment

13



29

Return to Contents

Return to Contents

Complete

15

16

Completion screen. You can click Save as PDF to save 

the acknowledgement of filing in PDF format.

Or you can click Back to Dashboard and will be redirected back to the  

dashboard.

15 16

Service of Originating Summons – Make Payment
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2

1

Return to Contents

Return to Contents

Attempt Service via SYC Portal - Plaintiff

If you choose to serve the Originating Summons via the SYC 

Portal, navigate to the Option B. Please read the description.

To select this method, click on Attempt Service via SYC Portal.

You will be directed to the Important Notes. Please read 

through the Important Notes.

You will need to tick that that you have read and agree to the  

Privacy Statement and Term of Use before the Agree and 

Proceed button is enabled

Click on Agree and Proceed to continue.

1

2

3

4

5

3

4

5
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6

Return to Contents

Return to Contents

Attempt Service via SYC Portal - Plaintiff

You will find a list of the documents in the Originating Summons 
Service Bundle.

Choose the party on whom the documents will need to be 
served by selecting the checkbox.

Verify the Defendant/Defendant Solicitor’s Details.

Click on Preview to view the information in non-editable format 

before submission.

6

7

8

9

7

8

9
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If there are no changes to be made, click on Submit.

11

10

Return to Contents

Return to Contents

12

If there are changes to be made in the preview page, click on 

Back to Edit

Attempt Service via SYC Portal - Plaintiff

Verify the form in Preview Mode.

10

1211
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13

13

Return to Contents

Return to Contents

Attempt Service via SYC Portal - Plaintiff

In the Declare section, select the checkbox to make the  
declaration.

Click on Make Payment to continue. Please refer to pages 24 to 

28 on how to Make Payment.
14

14
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1

Return to Contents

Return to Contents

Attempt Service via SYC Portal – Defendant’s View

If Attempt Service via SYC Portal is selected by the 

Plaintiff/ Plaintiff’s lawyer, once the Defendant logs in to SYC 

Portal, the Defendant will receive a Dashboard task to Accept 

Service of Documents via SYC Portal. Click on the hyperlink of 

the Case ID for that task.

At the declaration page, tick the checkbox to accept service of 

the documents via SYC Portal and the Submit button will 

be enabled.

Click on Submit.

1

2

3

2

3
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4

Return to Contents

Return to Contents

Attempt Service via SYC Portal – Defendant’s View

The submission page will be displayed.

Click on Back to Dashboard to return to the Dashboard.

The Originating Summons Service bundle will be available to 

the Defendant under the Divorce tab in the Court File > Court 

Documents folder.

5

4

5

5
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2

2

1

Return to Contents

Return to Contents

3

Filing of Summons (Application for 

Substituted Service) & Affidavit

If you choose to serve the Originating Summons by filing a   

Summons (Application for Substituted Service), navigate to 

Option C and click on File Summons (Application for 
Substituted Service).

Please read through the description for information on this 

mode of service.

Once you click on File Summons (Application for 

Substituted Service), you will be directed to the Important 

Notes. Please read through the Important Notes

Select the checkbox to confirm that you have read and agree 
to the Privacy Statement and Term of Use.

The Agree and Proceed button will only be enabled thereafter.

Click on Agree and Proceed to continue.

3

5

4

4

1

5
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8

6

Return to Contents

Return to Contents

Filing of Summons (Application for 

Substituted Service) & Affidavit

8a

7

The initial Status of the filing will be Draft.

On the header you will find a navigation bar to guide you on the 

steps to completing the Filing of Summons (Application for 
Substituted Service), which are:

a) Summons & Affidavit

b) Make Payment

c) Complete

In the main Filing of Summons (Application for 

Substituted Service) page, the following sections must 

be completed:

a) Summons (Application for Substituted Service)

b) Affidavit-in-Support

6

7

8b
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9

Return to Contents

Return to Contents

Filing of Summons (Application for 

Substituted Service) & Affidavit

For each section, you will find a flag to indicate whether the 

section is Completed (Green)  / Incomplete (Yellow)

You can only click Submit to proceed to payment and to  

submit the filing once all the mandatory sections have been 

marked as Completed (Green).

Alternatively, you can click Back and will be directed to 
the Divorce > Ongoing Filing section.

10

10

11

9a

9b

11
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Return to Contents

Return to Contents
Filing of Summons (Application for 

Substituted Service) & Affidavit

Click on Proceed to Summons (Application for Substituted 
Service) to start filing the Summons.

You will be directed to the Important Notes page. Please read 
through the Important Notes.

Select the checkbox to confirm you have read and agree to the 

Privacy Statement and Terms of Use.  Once you have done so, 

the Agree and Proceed button will be enabled.

Click on Agree and Proceed to continue.

Alternatively, you can click on Back to Filing of Summons  

(Application for Substituted Service) and will be redirected back 

to the previous filing page.

12

13

14

Section 1 Summons (Application for Substituted Service)
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19

17

18

Return to Contents

Return to ContentsFiling of Summons (Application for 

Substituted Service) & Affidavit

17

18

19

Choose the party on whom the documents will need to be served by 
selecting the checkbox

Select the documents to be served. By default, the system will 

populate generated and endorsed court documents of filed and 

accepted documents from the Originating Summons Service Bundle.

If you need to serve any additional document, tick on Others, 
and specify the additional document to be served.

Section 1 Summons (Application for Substituted Service)
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22

20

21

Return to Contents

Return to ContentsFiling of Summons (Application for 

Substituted Service) & Affidavit

20

21

22

Select whether you would like to use Standard Orders by clicking 
on (YES/NO).

If you are using the standard orders (option YES), Order #1 will 

be shown with a selection of methods of service of the documents:

a) By inserting an advertisement

b) By sending copies of the documents via registered post

c) By sending an electronic copy of the documents via email

For option NO to using standard orders, please refer to slide 52.

Order #2 will be auto populated and non-editable.

If you need to add an additional order, click on Add Order.

If you need to remove the additional order, click on Remove Order.

23

24

23

24

Section 1 Summons (Application for Substituted Service)
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27

25

26

Return to Contents

Return to ContentsFiling of Summons (Application for 

Substituted Service) & Affidavit

25

26

27

If you select the method of service as By inserting an 
advertisement, you will need to do the following :

Key in Name of Publication (the Name of Newspaper that 

the advertisement will be published in)

Select the Country of Publication

Specify the Circulation (city of publication)

If you wish to insert more than one advertisement, click on 

Add Publication button, and repeat step nos. 26 to 28 above.

28

29

28

29

Section 1 Summons (Application for Substituted Service)
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32

30

31

Return to Contents

Return to ContentsFiling of Summons (Application for 

Substituted Service) & Affidavit

30

33

34

If you select the method of service as By sending copies of 
the documents via registered post, you will need to do the following:

Specify whether the for service is Local or Overseas.

If you select Local address, key in the postal code, and click on 
Retrieve Address.

Verify the auto populated Block No., Street Name & Building Name.

Key in Level No & Unit No.

If the address does not have level & unit no., answer this question: 

Does the address contain Level No. and/or Unit No. (YES/NO) as 

NO.

35

36

33

34

31

32

35

36

Section 1 Summons (Application for Substituted Service)
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39

37

38

Return to Contents

Return to ContentsFiling of Summons (Application for 

Substituted Service) & Affidavit

37

If you select the method of service as By sending electronic copy 
of the documents via email, you will need to do the following:

Key in the Defendant’s email address.

Once you have selected the method of service and completed the  

fields required, the Preview button will be enabled, for you to verify 

all information in non-editable format.

Alternatively, you can click Save as Draft to save the Summons as 

a draft, or click Back to Filing of Summons (Application 

for Substituted Service) and will be redirected to the previous 

filing page.

40

38

3940

Section 1 Summons (Application for Substituted Service)



48

43

41

42

Return to Contents

Return to ContentsFiling of Summons (Application for 

Substituted Service) & Affidavit

If you select "No" to using the Standard Orders, follow the steps 
below.

Key in the orders you are applying for in the text box.

Once you have keyed in the orders, the Preview button will be 

enabled for you to verify all information in non-editable format.

Alternatively, you can click Save as Draft to save the Summons as 

a draft or click on Back to Filing of Summons (Application 

for Substituted Service) and will be redirected to the previous 

filing page.

44

42

4344

41

Section 1 Summons (Application for Substituted Service)
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47

45

46

Return to Contents

Return to ContentsFiling of Summons (Application for 

Substituted Service) & Affidavit

In the preview mode, verify all the information in non-editable format.

Once you have verified the information, click on Complete to 

complete the Summons.

Alternatively, you can click Save as Draft to save the Summons as 

a draft or you can click on Back to Edit to update or amend the 

Summons.

4647

45Section 1 Summons (Application for Substituted Service)
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50

48

49

Return to Contents

Return to ContentsFiling of Summons (Application for 

Substituted Service) & Affidavit

On clicking Complete, you will be directed to the Declaration 
section. Select the checkbox to make the declaration.

Click Complete & Back to Filing of Summons (Application 
for Substituted Service) to confirm completion of the Summons.

Alternatively, you can click on Back to Preview to go back to 
the preview mode of the Summons.

Once you have clicked Complete & Back to Filing of 

Summons (Application for Substituted Service), the system will 

mark this section as Completed (Green) and you will be redirected 

back to the main Filing of Summons (Application for Substituted 

Service) page.

On the main Filing of Summons (Application for Substituted 

Service) page, you will find the section for the Summons (Application 

for Substituted Service) marked as Green (Completed).

If you click the button Edit/View Summons (Application for 

Substituted Service), this section will revert to Yellow (Incomplete).  

You must complete the section up to step 51 to mark this section as 
Completed.

49

48

50

51

52

51

52

Section 1 Summons (Application for Substituted Service)
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Return to Contents

Return to Contents
Filing of Summons (Application for 

Substituted Service) & Affidavit

To proceed with filing the Affidavit In Support, click on the 

button Proceed to Summons Affidavit-in-Support

You will be directed to the Important Notes page. Please read 

through the Important notes and select the checkboxes to confirm 
the Pre-Requisites.

Select the checkbox to confirm that you have read and agree to the 

Privacy Statement and Term of Use. The Agree and Proceed button

will only be enabled once you have done so.

Click on Agree and Proceed to continue.

Alternatively, you can click on Back to Filing of Summons 

(Application for Substituted Service) and will be redirected back 

to the main filing page.

53

54

55

Section 2 Affidavit-in-Support

56
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54
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5657
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60

58

Return to Contents

Return to Contents

Filing of Summons (Application for 

Substituted Service) & Affidavit

60

59

The initial status of Affidavit-in-Support is Incomplete.

On the header you will find a navigation bar to guide you on 
the steps to complete the filing of Affidavit-in-Support, which are:

a) Affidavit-in-Support

b) Preview & Save

Click Choose File to upload the completed and affirmed Affidavit-
in-Support.

Key in Deponent’s Name.

You can an add additional Affidavit-in-Support by clicking on 

Add Affidavit-in-Support.  You can upload a maximum of 2 

affidavit files for each Summons.

The Preview button will be enabled after steps 60 and 61 

are completed.  You may refresh the tab to enable the Preview 

button to verify the keyed in information in non-editable format 

before completion.
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Section 2 Affidavit-in-Support
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66

64

Return to Contents

Return to Contents

Filing of Summons (Application for 

Substituted Service) & Affidavit

64

65

Verify the uploaded affidavit information in preview mode.

Once you have verified, click on Complete & Back to Filing 
of Summons (Application for Substituted Service).

Alternatively, you can click on Back to Edit to edit the 

Affidavit page.

After step no.65, the system will mark this section as 

Completed (Green) and you will be redirected back to the main 
Filing of Summons (Application for Substituted Service) page.

If you click the Edit/View Affidavit-in-Support button, this 

section will revert to Yellow (Incomplete). You must complete this 
section up to step no. 65 to mark this section as Completed.

65
66

67

68

67

68

Section 2 Affidavit-in-Support
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71

69

Return to Contents

Return to Contents

Filing of Summons (Application for 

Substituted Service) & Affidavit

70

All sections need to be marked as Completed (Green) before 
you can proceed to submit the filing and make payment.

Once all required sections are completed, the system will 

enable the Make Payment button. Please refer to pages 24 to 
28 on how to make payment.

Alternatively, you can click Back to Service of 

Originating Summons button and the system will redirect you 
back to the Service of Originating Summons page.

69a

70

69b

71
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Return to Contents

Return to Contents

When a draft of the Filing of Summons (Application for Substituted 

Service) is created, after it has been submitted, and when it is 

Returned as Incomplete, you may view the status of the submission in 

the Divorce tab, in the Ongoing Filing section.

If the submission is Returned as Incomplete you may view the remarks 

by clicking View Remarks under the Remarks column.

Filing of Summons (Application for Substituted 

Service) & Affidavit

72

73

72

73
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Return to Contents

Once the Filing of Summons (Application for Substituted Service) is 

accepted, the submission will be shown in the Completed Filing 

section of the Divorce tab.  If the Filing of Summons (Application for 

Substituted Service) is rejected, it will also be shown in the Completed 

Filing section of the Divorce tab. 

The accepted Filing of Summons (Application for Substituted Service) 

may be found in the Court File -> Court Documents section of the 

Divorce tab.

74

75

Filing of Summons (Application for Substituted 

Service) & Affidavit

75

74
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2

1

Return to Contents

Return to Contents

Personal Service Attempt by Court Process Server

If you have indicated that the Defendant is in prison in your 

accepted filing of Originating Summons, the only available 

method of service of the Originating Summons is Personal 

Service Attempt by Court Process Server. Please read through 

the description for information on this mode of service.

To continue, click on Pay for Personal Service Attempt by 

Court Process Server.

You will be directed to Important Notes.  Please read through the 

Important Notes. 

Select the checkbox to confirm that you have read and agree to 
the Privacy Statement and Terms of Use. 

The Agree and Proceed button will be enabled after you have 

done so. Click on Agree and Proceed to continue.

1

2

3

4

5

3

4

5



59

6

Return to Contents

Return to Contents

6

Personal Service Attempt by Court Process Server

Fill in all the required fields :

a) Is the Defendant/Respondent in prison/incarcerated? 

(YES/NO)

b) Inmate No.

c) Length of Imprisonment

d) Release Date (Optional) 

e) Address of Defendant/Respondent after release. Please 

choose whether it will be:

• Same As Residential Address

• Others (Key in Address)

Once you have completed the fields required, the Preview button 

will be enabled, for you to verify all information in non-editable 
format.

Alternatively, you can click on Save as Draft to save as a draft, or 

on Back to Service of Originating Summons and will be 

redirected to the previous page.

7

7
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Alternatively, you can click Back to Edit to revert to edit mode.

9

8

Return to Contents

Return to Contents

10

Personal Service Attempt by Court Process Server

In the preview mode, verify all the information in non-editable 

format.

Click on Submit to continue.

8
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12

11

Return to Contents

Return to Contents

To proceed with payment, click on Make Payment. Please refer 

to pages  24 to 28 on how to proceed with Payment.

Personal Service Attempt by Court Process Server

On the Declare section, read and confirm the declaration by 

clicking on the checkbox.

11
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Service of Originating Summons – Status Update

1 If there is no update on the status of Service of the Originating  

Summons 21 days after selection of the method of service, 

you will receive a task "Service of Originating Summons 

Status Update" on your Dashboard to update the status of the 
service.

Click on the 3 dots under More Options > View to start the 

update of the status of Service of the Originating 
Summons. Alternatively, you can click on the Case ID hyperlink.

2

Return to Contents

Return to Contents
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Service of Originating Summons – Status Update

3 Update the status of the Service of Originating Summons 

by selecting one of the following:

a) Service is not yet attempted

b) Defendant/Respondent is overseas/address unknown

c) Defendant/Respondent is now in prison

d) Defendant/Respondent did not respond

Return to Contents

Return to Contents

3



65

Service of Originating Summons – Status Update

4 If you select Service is not yet attempted, you are required 

to provide further details:

a) "Do you wish to select a new method of service" (YES/NO)

b) "Do you wish to re-schedule the appointment" (YES/NO)

Select YES or NO for both questions.

Click on Update to submit the status update.

Return to Contents

Return to Contents
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Service of Originating Summons – Status Update

6 If you select Defendant/Respondent is 

overseas/address unknown, you are required to provide further 

details :

a) "Do you wish to select a new method of service" (YES/NO)

Select YES or NO. If you select YES, refer to page 66 after step 
no. 7.

Click on Update to submit the status update.

Return to Contents

Return to Contents
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Service of Originating Summons – Status Update

8 If you select Defendant/Respondent is now in prison, the only 

available alternative method of service is Personal Service 

Attempt by Court Process Server. You will receive a task on 

your dashboard to attempt this method of Service of the 
Originating Summons thereafter.

Please refer to pages 54 to 58 on Personal Service Attempt by 
Court Process Server.

Click on Update to send the status update.

Return to Contents

Return to Contents
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Service of Originating Summons – Status Update

10 If you select Defendant/Respondent did not respond, you 

will be required to answer:

a) Do you wish to select a new method of service (YES/NO)

Select YES or NO.  If you select YES, you will be able to select 
new method of service by repeating steps on pages 7 to 11.

Click on Update to submit the status update.

Return to Contents

Return to Contents
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Service of Originating Summons – Status Update

12 If you select "YES" to the question “Do you wish to select a 

new method of service”, the current selection of method of 

service will be shown under Type of Service of Originating 

Summons.

The other available methods of attempting Service of 

the Originating Summons will be shown as options below.

Select one of the options. Please refer to the steps from pages 7 
to 11 to attempt the new method of Service

Return to Contents

Return to Contents
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